
It is an exciting time to 
be a part of Intermedi-
ate School District 917.  
We have nearly 100 
more students enrolled 
in our special education 
programs this year than 
we did last year.  Much 
of this can be attributed 
to the addition of the 
Youth Transition Pro-
gram but many of our 
other programs are also 
expanding.  We continue 
to add new staff.  Just 
last week we had two 
additional people ap-
proved to serve as com-
munity experts—one at 
Alliance Education Cen-
ter and another in our 
Deaf/Hard of Hearing 
Program.   
 
Once again, I have had 
the opportunity to ob-
serve in classrooms 
across the district this 
school year.  I have also 
been able to meet with 
staff to listen as they 
shared concerns about 
various aspects of their 
jobs.  What I continue to 
be struck by is your ded-
ication to provide quali-
ty educational experi-
ences for the students 
we serve.  This focus is 
evident even when be-
haviors are challenging 
and other tasks demand 
attention. 

The time in classrooms 
and with you provides 
practical knowledge that 
assists me in the work I 
do each day.  This fall 
that has included: 
 Meeting with repre-

sentatives including 
advocates with the 
Restrictive Proce-
dures Work Group 
at the Minnesota 
Department of Edu-
cation 

 Serving as a panelist 
on the Restrictive 
Procedures Reduc-
tion Discussion:  
Eliminating Prone 
Restraint 

 Representing Inter-
mediate School Dis-
tricts with the De-
partment of Human 
Services and the 
MDE with regard to 
the Olmstead Plan 

and specifically crisis 
intervention provid-
ed by counties in the 
school setting 

 Space planning for 
the 2015-2016 
school year and be-
yond  

 Program planning 
and staffing for the 
2015-2016 school 
year 

 
With all that is happen-
ing, it is a good time to 
reflect and take time to 
rejuvenate over the up-
coming break.  Enjoy 
your time with family 
and friends.  Rest and 
relax! 
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In this edition, there are a few 
items to remember when com-
pleting IEPs. 
 
IMPORTANT:  IEP Adaptations 
Language – Extra-Curricular  
Activities 
A statement is needed in the Ad-
aptations section of IEPs address-
ing accommodations needed by 
learners when participating in ex-
tra-curricular activities in their 
home districts.  When an IEP team 
is alerted of a learner’s participa-
tion, or desire to participate, in an 
extra-curricular activity(ies) in the 
learner’s home district, the IEP 
team will meet, or provide input 
through communication facilitated 
by the IEP manager, to determine 
if participation in the particular 
extra-curricular activity is appro-
priate, and if so, what accommo-
dations may be needed. 
 
Documenting Transportation 
Plans in i-Plan  
The documentation of a learner’s 
Transportation Plan in i-Plan is a 

Due Process Dialogue 

By Kitri Larson Kyllo, Assistant Director/Principal and Sayra Mayberry, Licensed School Nurse 

relatively new requirement for 
IEP managers when completing a 
learner’s IEP. This portion of i-
Plan needs to be completed on 
intake of a newly enrolled learn-
er, and annually at the time of 
the new annual IEP.   A learner’s 
Transportation Plan will need to 
be revised any time a student’s 
needs, emergency medication, 
program or equipment changes.   
 
The Transportation Plan is locat-
ed in the section labeled ‘Other’ 
in i-Plan under Transportation 
Plan. 
 
The plan is in checklist form and 
has areas to list both parent and 
medical contacts, which can be 
found in the learner’s current 
Student Emergency Contact 
Form. It also request information 
on the physical, medical, behav-
ioral and communications issues 
a student may have.  There are 
corresponding boxes in each sec-
tion to describe the student’s 
needs.   

 
There is also a section listing 
Preferred Method of Transfer 
and Procedure in event of an 
emergency evacuation.  There 
are four options to choose from 
in a drop-down menu. 
 
It is not necessary to list medi-
cations unless they are needed 
on the bus in event of emer-
gency.  If a student has a health 
plan/medical issue requiring 
equipment, medication or pos-
sible emergency treatment dur-
ing the bus ride, the 917 Li-
censed School Nurse must com-
plete the medical section.   
 
This completed form is re-
quired by Minnesota Board of 
Education Rules to be on each 
bus the student rides. The form 
should be completed with par-
ent input and requires parent 
signature.   
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Have you ever wondered about the 
Minnesota  system of care and treat-
ment facilities and how Intermediate 
School District 917 happens to pro-
vide direct educational services at 
several of them? Based on the grow-
ing numbers of students out of their 
home schools due to mental health or 
correctional services, member dis-
tricts Hastings and Burnsville, invited 
Intermediate School District 917 to 
serve those students at facilities locat-
ed within their districts. Beginning 
with LifeSpan-Youth Transition Pro-
gram (1986), followed by the Juvenile 
Services Center-Riverside and New 
Chance (1995), Options and Anthony 
Louis (2011), and back to YTP after a 
three-year hiatus (2014), students are 
thriving and interagency teams are 
invested in seamless provision of best
-practice services.  
 
Who attends Intermediate School 
District 917 programs in care and 
treatment facilities? How do stu-
dents end up there? What are their 
educational needs? How long do they 
stay?  Overall, students at these sites, 
grades kindergarten through twelve, 
have either general education or spe-
cial education needs. Teachers have 
an Experimental Program License to 
teach in their core academic areas. 
Due process is maintained for stu-
dents receiving special education ser-
vices.  All students attain hours and 
grades for each class attended which 
are sent back to the home districts to 
be evaluated for credit; in this way 
they do not lose educational time 
while at the care and treatment site. 
Each setting has an education and a 
treatment module so the academic 
day is shorter.  
 
Juvenile Services Center 
When students break the law they are 
taken into custody and brought to the 
Juvenile Services Center (JSC), which 

is comprised of two programs:  New 
Chance and Riverside.  New Chance is 
a court-ordered day treatment pro-
gram where the students complete a 
one-month evaluation, then appear 
before a judge and are sentenced to 
the remainder of their time in the 
program. A maximum of sixteen New 
Chance students typically remain for 
three months to a year. Riverside is 
the locked portion of the program 
with a forty-bed capacity where stu-
dents can be detained for just a few 
hours or be sentenced to stay for up 
to a year. The JSC has four classroom 
teachers to work with students 11-17 
years old.  They are: Linda Cornelius 
(science), Claudia Balk (reading), 
Dustin Rotegard (social studies), and 
Amanda Boehmer (math).  These 
teachers move back and forth be-
tween Riverside and New Chance. 
 
Youth Transition Program 
When students have mental health 
needs there are two care and treat-
ment centers where the education is 
provided by Intermediate School Dis-
trict 917.  Students are usually re-
ferred to these programs by parents 
of other providers.  One is the Youth 
Transition Program (YTP) run by 
Lifespan of Minnesota.  It is a K-12 
mental health day-treatment pro-
gram comprised of a half day of ther-
apy and a half day of education.  
There are about 70 students enrolled 
at any given time who typically re-
main for three months to a year.  YTP 
has six classroom teachers.  There are 
two elementary teachers: Marta Nel-
son (grades K-3) and Michael Burgio 
(grades 4-6).  There are two middle 
school teachers: Sara Tuvey (math 
and English) and Cailin McGrath 
(social studies and science).  There 
are also two high school teachers:  
Jane Robinson (English and social 
studies) and Nicole Hennes (math 
and science).  The students alternate 

therapy and their two grade-level 
classrooms. 
 
Options Family and Behavior Ser-
vices 
The second care and treatment pro-
gram where Intermediate School 
District 917 provides education for 
students with mental health needs is 
Options. Students may receive men-
tal health or chemical health treat-
ment or a combination.  Options 
Family and Behavior Services is a day
-treatment program where students 
in grades 7-12 receive a half day of 
education and half day of therapy.  A 
maximum of 33 students attend this 
program for six weeks up to a year. 
There is one full-time teacher, Sha-
ron Votel, who teaches English, 
math, science, and social studies. 
There is also a .5 teacher, Hannah 
White, who teaches math and sci-
ence.  
 
Anthony Louis 
When students primarily have chemi-
cal health needs, the Intermediate 
School District 917 program choice is 
Anthony Louis.  Again, students are 
usually referred by parents or other 
providers.  Students in grades 8-12 
receive a half day of education and 
half day of therapy. A maximum of 
18 students attend this program 
from four to eight weeks. Hannah 
White is the teacher at Anthony Lou-
is and she teaches math, science, 
English, and social studies before she 
travels over to Options to teach in 
the afternoon. 
 
District 917’s longstanding presence, 
leadership, and participation in edu-
cational settings for students with 
diverse needs, along with staff expe-
rience, optimism, and flexibility have 
enhanced the contributions of these 
very innovative sites! 

Care and Treatment Services 
 
By Jennifer Hetland, Assistant Director/Principal 
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Accommodations for Grade 11 ACT Plus Writing 

By Dave Stoll, Assistant Director 

This spring Grade 11 students will 
be participating in the state ad-
ministration of the ACT Plus 
Writing as part of their testing 
requirements for graduation.  
This assessment is in addition to 
the Grade 11 MCA Math Assess-
ment.  Grade 11 students who 
qualify for the MTAS do not take 
the ACT Plus writing.  There are 
only 2 dates for taking the test:  
April 28th is the test date and May 
12th is the makeup test date. 
 
There are three different types of 
accommodations based on who 
approves the accommodations.   
First, there are accommodations 
that are approved by ACT.  If the 
accommodations are approved by 
ACT, then the student may use the 
scores for college applications, 
scholarships, etc.  Below is a list of 
accommodations that ACT may 
approve: 
 Large type 
 Braille 
 Script 
 Raised-line drawings 
 DVDs 
 Extended time 
 Testing over multiple days 
 Additional breaks 
 Scribe for writing test or to 

circle answers for multiple 
choice 

 Computer for writing test 
 
In order for the accommodation 
to be approved by ACT, the 
school assessment coordinator 
must submit a request and docu-
mentation to ACT.  Depending on 
the disability and accommodation 

being requested, the required 
documentation may include cop-
ies of test accommodations and 
service pages from the IEP, special 
education evaluation, medical re-
ports, or psychological reports 
that are less than a year old.   
 
The window for submitting re-
quests for ACT approval is early 
December through January 23rd.  
Once ACT receives the request, 
they will review the information 
and then let the district know if 
the request has been approved or 
denied.  If the request is denied, 
the district can appeal the deci-
sion. 
 
The second type of accommoda-
tions are those allowed by the 
Minnesota Department of Educa-
tion.  These accommodations are 
the same as the ACT-approved 
accommodations, but the scores 
cannot be used by the student for 
college entrance or scholarship 
applications.  In other words, if 
the district requests approval 
from ACT for testing over multiple 
days for a student and ACT denies 
the request, the student may still 
test over multiple days as a MDE-
allowed accommodation, but ACT 
will not send the scores to colleg-
es or as part of scholarship appli-
cation.  The eligibility require-
ments for the MDE-allowed ac-
commodations are the same as 
accommodations for the MCAs 
listed on the state testing/
accommodations page of the IEP, 
and are accommodations needed 
and used as part of the student’s 

classroom accommodations. 
 
The third type are locally ap-
proved accommodations.  The 
scores from tests completed using 
locally approved accommodations 
are reportable to colleges and 
scholarships if used in conjunction 
with ACT-approved accommoda-
tions.  If locally approved accom-
modations are used in conjunction 
with MDE-allowed accommoda-
tions, the scores are not reporta-
ble.  Options for locally approved 
accommodations are: 
 Wheelchair accessible room 
 Seating near the front of room 
 Color overlays 
 Individual or small group 

testing 
 Food, drink, or access to medi-

cation for examinees with 
medical needs 

 Visual notification of time 
 Sign language interpretation 

(cannot be a relative and can-
not be used with test items) 

 Examinee circling answers in 
the test booklet (testing staff 
must transfer to answer docu-
ment) 

The locally approved accommoda-
tions must be consistent with the 
student’s IEP, cannot disrupt 
testing for other students, cannot 
provide the student with an ad-
vantage, and cannot not provide 
for additional breaks. 
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Back-Up Using iTunes 

By Pam Garretson, Computer Network Specialist 

Use these steps to back up the content on your iOS device to iTunes on your computer: 

1. Make sure your computer has the latest version of iTunes.   (As of 11-25-14, the most current iTunes  version is 
12.0.1.26) 

2. Connect your device to your computer. 
3. Go to File > Devices > Back up. 

 
 

You can also back up by syncing your device with your computer. When you use iTunes to sync, backing up is the 
first step. 
 

4. To confirm that the backup finished successfully: 

Go to Edit >Preferences >Devices  
You'll see the name of the device along with the date and time iTunes created the backup. 
 

 
 

http://www.apple.com/itunes/download/
http://support.apple.com/kb/HT1386
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The Mobile Pantry 

By PattiJo Nwokeuku, School Social Worker 

Intermediate School District 917 
has partnered with the Mobile 
Pantry through The Open Door in 
Eagan. The Mobile Pantry is an 
innovative approach in bringing 
food support to those who are in 
need of food assistance. The Mo-
bile Pantry comes to the Cedar 
SUN and IDEA, DCALS and TESA 
programs on a pre-arranged 
schedule, fully stocked with the 

same wholesome and healthy 
foods as a The Open Door. The 
Mobile Pantry comes to the Cedar 
SUN and IDEA three times per 
month. The Mobile Pantry  
is providing 18 students with this 
wonderful service. The DCALS 
and TESA programs receive the 
Mobile Pantry one time per 
month.  ISD 917 students are able 
to bring the food items home with 

them.  Like The Open Door, 70% of 
the food offered on the Mobile 
Pantry is fresh and perishable. The 
Mobile Pantry also provides the 
Cedar site with a box 
of nutritional food items and hy-
giene products for students.   

Back-Up Using iTunes (continued) 

Use these steps if you have a new iOS device, or to restore after a factory reset:  
1. Connect your device to the computer that has your backup. 
2. Install the latest version of iTunes. 
3. Go to File > Devices > Restore from Back up. 

 
*iOS does not support restoring a backup from a newer version of 
iOS to a device using an older version of iOS. For example: Restor-
ing a backup from an iOS 7 device to an iOS 6 or earlier device is 
not supported. 
 
*If you need to transfer content from a device with a newer ver-
sion of iOS to a device using an earlier version, you can do so 
through USB syncing. However, restoring from a newer version IOS 
to an older version will very seldom be used in our district. 

http://www.apple.com/itunes/download/
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i-Plan Updates  

By Jennifer Klaustermeier, Teacher, TESA 

Here are the latest updates to i-
Plan: 
 The Document of Significant 

Change form is no longer 
available under Blank Forms. 

 All Historic plans for students 
are now displayed for the 
roles of Coordinator and User. 
Click on the “H” icon next to 
the student’s name. 

 The form, Authorization to 
Release Information, under 
Other changed the wording of 
‘Signature of Patient or Au-
thorized Person’ to ‘Signature 
of Student or Authorized Per-
son. ’ It also changed the 
wording of ‘Reason patient is 
unable to sign’ to ‘Reason stu-
dent is unable to sign.’ 

 The Transfer Plans (mass 
transfer) for Managers now 
includes the Plan Status. 

 
Page 4—Assessments/
Accommodations 
 Under State Assessments for 

Accountability for Reading 
and Math, ‘MCA-Modified’ 
will no longer display. 

 The heading ‘Diploma Re-
quirements’ changed to 
‘Graduation Assessment Re-
quirements.’ 

 The heading ‘Record or Status 
of Proficiency in Meeting Di-
ploma Requirements’ changed 
to ‘Record of Meeting Gradua-
tion Assessment Require-
ments.’ 

 A new section, ‘Alternative 
Graduation Requirement As-
sessment’ was added. This 
includes a date field with a 

calendar and a district-defined 
drop-down list box so districts 
can add any of the new tests 
they use for testing such as: 
WorkKeys, Compass, ACT, or 
ASVAB. 

 
Changes to the IFSP include:  
 IFSP Meeting Date now uses 

the same field as the Annual 
IEP on the Plan Status page. If 
the IEP Annual Meeting Date 
is filled in, it will populate to 
the IFSP Meeting Date field.  

 The text editor was added to 
the Summary of All Develop-
mental Areas, Family Assess-
ment, and the ‘Periodic Re-
view’ field on the Child and 
Family Outcomes page.  

 All fields can now be updated 
in Active plans for the Transi-
tion Planning form.  

 On the Prior Written Notice/
Parent Consent (Part C), the 
‘Proposed Evaluation/
Assessment Procedures’ have 
been broken out into three 
areas: Procedures, Domain/
Purpose, and Team Member
(s).  

 There is a new form for the 
Prior Written Notice of Educa-
tional Evaluation/
Reevaluation for Part C under 
the Evaluate Menu. Part C and 
Part B forms will be displayed 
under the menu. 

 
Things to Remember  
 To use these new features you 

must make a copy of your ac-
tive plan.   

 When importing a Word docu-

ment into i-Plan, make sure 
the style ‘Normal’ is selected 
for the whole document and 
to use Arial 8 or Arial 9-point 
font.  

 Also remember to always use 
the ‘Log out’ button in the 
upper right corner, not the 
red ‘x’ button when logging 
out of i-Plan.  
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Mosley is Moving  

By Don Budach, Assistant Director of Special Education/Principal 

Phone:  651-423-8377 

Fax:  651-423-8776 

www.isd917.k12.mn.us 

Mosley the Moose is didn’t let the cold 
weather keep him from making his way 
down to the PACES program, located at 
Boeckman Middle School in Farming-
ton. Mosley trekked over from Century 
Middle School in Lakeville, after having 
spent time there with all the amazing 
students and staff in the Deaf/Hard of 
Hearing Program.  
 
The hard working assistants and related 
services staff working in coordination 
with teachers Shelli Vollbrect and Amy 
Lancaster definitely enjoy Mosley’s 
presence at PACES. They feel honored 
that Mosely has come to recognize 
their hard work there.     
 
After arriving at PACES, Mosely quickly 
realized how hard everyone works in 
the program and the dedication they 
have to meet students’ unique needs in 
a positive supported environment.  
As Mosley has spent time in PACES, he 
has been able to see first-hand all the 
wonderful things happening with stu-
dents.  Mosely was given time to partic-
ipate with the students in a number of 
general education classes. Classes 
Mosely attended were music, art, fami-
ly and consumer science, DAPE, Tiger 
Time, media art, keyboarding, science, 
language arts and math.  
 
Mosely also had the chance to build his 
technology skills by utilizing the iPad to 
access ViZzle lessons as well as Schoolo-
gy.  Mosely appreciates all the sensory 
breaks, visuals and communication 
tools, which are in place so Mosely and 
the others can better focus on academ-
ics and functional skills.  
 
Students in PACES are making great 
progress as they are spending time with 
non-disabled peers, all of which adds to 
their social and emotional confidence 
and overall social skills. As well, parents 
at IEP meetings are extremely happy 

with the gains their children are mak-
ing while attending the program. Par-
ent support and confidence has been 
reflected through the donation of 
funds and resources. An example of 
this recently occurred in Shelli’s room 
in which a parent has made a donation 
of on-going music therapy for the re-
mainder of the school year. The goal of 
the music is to enhance the academic 
and social environment in the class-
room through a fun and motivating 
approach. 
 
After arriving and spending time at 
Boeckman PACES, Mosley now realizes 
that Shelli and Amy, along with their 
outstanding support staff, which in-
cludes: Bev, Dan, Nicole, Deb, Amy, 
Jake, Sue, Heather, Natalie, along with 
related service staff: Jason Nickleby, 
Sue Friest and Elizabeth Annoni, all 
display a passion for meeting the col-
lective and individual needs of stu-
dents. They are able to do this by con-
tinually planning, preparing and prob-
lem-solving for the students they 
serve.   


